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ATTENTION ON SAFETY

1. Security on the mark:

About the safety precautions and the use of instruments in this manual, the following
important matters of each display, in order to prevent accidents and dangerous, sure to
observe the following danger, warning, attention to the narration:

Danger:
This display of the project, who fails to comply, the operation may be
affected by the injury.

Warning:

This display of the project, such as failing to comply with possible

damage to the instrument.

Attention:
This displays the project may affect the test results and quality.

【Note】

In this display, the product use help in the operation.

2. In this instrument, the mark that attention,warning.

Warning sign
This notation is necessary to refer to

the place of the operating manual.

Hazardous voltage sign
This notation is the danger of high

voltage.

Ground protection mark
In the instrument on the ground

terminal.
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Technical Parameter:

Model UTM-1001B 1KN Computer Servo Peeling Testing Machine

Maximum load 1KN

Capacity choice 200N, 500N, 1KN or less than can be self-selected

Unit KG,N,LB, TON can be exchanged.

Measurement system Load cell + HZ-2000

Accuracy load of measurement the load cell + HZ-2000 screen ± 0.5% (full range of 5% -100%)

Resolution 1 / 50000

Maximum test stoke About 500mm ( can be customized )

Test speed 50-300mm / min with stepless speed and 5 fixed-speed (can be customized )

Data sampling frequency 200times/sec

Machine with thermal printers can automatically output the testing results.

Can store 10 testing results and auto-calculate its average, auto-grab maximum force and the force at break.

Display Computer display

Machine size 45x58x135cm (length*width*height)

Weight 75KG

Ratio of Breakpoint
from 0 ~ 99%, which the user can set according to different materials
to stop the machine, realizing stop machine at any position.

Safety The system would shut down if overload or over-trip.

Shape column shell is made of aluminum material.

Power system AC Motor

Power 120W(depending on different demand of force using different motor)

Equipment Summary:

UTM-1001B 1KN Computer Servo Peeling Testing Machine a simple type machine, simple structure,

convenient operation, It can be tested on the operated table, Using the electronic control systems, load

sensor is rising and falling to test the tension or compression through the motor rotation, transmission

machinery and T-screws. This machine is simple to operate, especially suitable for controlling quality in

production line, This series of machine is mainly applied to test the non-metallic and metallic materials

which the load is less than 1KN.
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Main Functions:

This machine can be test all the material in tensile, compression, bending, shear, peel, tear, two-point

extended (need add extensometer) and others for control products quality. Such as textile, rubber,

plastics, synthetic leather, tape, adhesive, plastic film, composite materials, electronics, metals and

other materials.

Main Feature:

1. Excellent design. my company has focused on product appearance over the years, company has

developed many products that is similar with the foreign products, the surface of product is made of

aluminum and process by electrostatic spray

2. Digital force displayed by LCD , discernible tension or pressure, LCD display clearly

3. Three kinds of units: N ,Kg ,Lb ,ton option or automatically exchange;

4. LCD with backlight can be used in low-light environments

5. Single measurement, it can record the max force of tension and compression in both directions,

automatic or manual cleared to zero.

6.The system would shut down if overload or over-trip

7. Structure of single-column is beautiful and sophisticated, seating operation, relaxation and nature.

Corresponding Standard:

《GB/T16491-1996 electronic universal testing machine》

Applicable Industry：

It is widely used in wire and cable, hardware, electronic and electrical equipment, packaging, printing,

medical equipment, auto parts, textiles and leather, clothing, shoes, rubber and plastic products,

colleges and universities; research laboratories; inspection arbitration, technical supervision

departments and many other industries, it is the basic equipment for quality management and physical

tested.
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1 Introduction of TM2101 measurement and control

system

The TM2101 measurement and control system is designed purposely for microcomputer

controlled electronic universal testing machine, microcomputer controlled universal

hydraulic testing machine and microcomputer controlled compress testing machine, used for

the test of tension, compress, bend, shear, tearing and peel. With the personal computer

and interface plate, it could collect, save, process and print test result. Further it can

calculate multiple parameters, i.e. maximum force, yield strength, average peel force,

maximum deformation, yielding point and elastic modulus; this system is featured in curve

process, multi-sensor support, image interface, flexible data process and powerful system

function.

1.1 Main function

1. Hardware
With a 32 bits ARM as the MCU, the test system has better overall performance、faster computational

speed and higher control accuracy than the traditional test system with 8 bits MCU.

The core device of acquisition system is ultra-high-precision 24 bits AD

(analog-to-digital converter) IC with data rate up to 2000 times per second, so it can capture

the transient process of the force, and the resolution can up to 500000 indexing. The system

with 6 points calibration has high accuracy which is far exceed the requirement of national

standard.

The displacement encoder with 4 frequency doubling technology can increase by 4 times the

resolution of displacement, up to 0.0005mm.

2 output control method: pulse and voltage, can control any Servo motor、inverter motor or DC

motor with pulse or voltage interface, achieve smooth stepless. In addition, with switch signal (such

as up、down or stop) to drive the external relay or solenoid valve, in order to control DC and pneumatic、

hydraulic pressure equipment.

Advanced loosed-loop technology for velocity、displacement and force can achieve precise control

of arbitrary waveform.

Multiple serial interfaces: Up to 4 channels 24 Bits analog input, 3 channels 16 bits analog input,

3 channels pulse input, 3 channels AB phase optical encoder input, 9 channels switching value input,

8 channels switching value output, 1 USB, 1 RS232, 1 485, 4 types of LCD interface, 1 parallel port

micro print interface, 1 serial port micro print interface, 1 8X4 matrix keyboard interface.

All input and output interface use high-speed photoelectric isolation technology, which makes

the system to have strong anti-interference capability.

2. Software
It is the most easy to use software in the test machine industry with windows standard style、

structured mode of operation and detailed help documentation and tips, so that you can significantly

improve the efficiency of debug and software training.

Use Multi-threaded parallel processing make the software can display “Force-Displacement”、
“Force-Time” 、 “Displacement-Time” and “Stress-Strain” curves simultaneously, so you can switch to

any graph which you want to see and check the user settings.

Standard test process control and report output temperate, can define any number of testing

standards (including GB、ASTM、DIN、JIS、BS、etc.) for user to call. Flexible and strong customize

testing method, with multi-control mode (Constant Speed、Constant Displacement、Constant Force、

Constant Force and Velocity、Constant Stress、Constant Stress and Velocity、Constant Strain、Constant

Strain and Velocity、etc.). Realize complex multi-step nested-loop control. Setting automatic return、

automatically determine the fracture and automatic zero.
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Strong ancillary tools with capability of data analysis, statistics and graphical analysis of

curves, which have zoom、pan、cross cursor、check points and other functions. Can transfer historical

data to graph many times, and can display to compare at the same time. Up to 7 interval setting、

30 manual sampling points and 60 automatic sampling points. Multiple statistical functions including

maximum、minimum、average、average after remove the maximum and minimum、median、standard deviation

and overall standard deviation.

Opening testing results edit method make user get any wanted test data. Up to 400 (such as maximum

force、fracture force、peel strength、tensile strength、shear strength、tear strength、maximum
deformation、yield strength、elongation、elastic modulus、ring stiffness、non-proportional elongation、
minimum force range、average force range and elongation under constant force) can be called by

user.

Microsoft Word report format for easily use.

Permission management can help you lock any function mode of the software, separate the software

into multiple permission levels, make the operation of software more secure.

Digital calibration system make the calibration process easily and efficient, double protection

on calibration data.

Powerful unit system, adapt to all unit system over through the world, for example, there are

more ten types of force unit, such as gf、kgf、N、kN、tf、lbf、ozf、tf (SI)、tf (long)、tf (short）.

Multiple protection mechanism: Over range protection of force、route and displacement, hardware

setting protection for up and down limit switch.

Intuitive and efficient test data management system: Single test data can be stored in Windows

standard format with free storage path and file name, so the data store has no limits.

All operations can instead of by shortcuts, can connect with the external manual control box,

can connect all the commonly used buttons such as Fast Up、Fast Down、Middle Speed UP、Middle Speed

Down、Slow Up、Slow Down、Zero、Clear、Return、Pause and Stop.

The language version can be easily switched: Chinese Simple、Chinese Traditional、English and

the advanced version have up to ten types of language: Japan、Korean、Russia、German、French、Spanish、

Portugal.

Green software, need not to install, can copy to computer directly (need install serial port driver

first), very easy to maintenance and upgrade.
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1.2 Technical specifications:

Force:

Resolution 1/250000

Precision 0.1%

Range Free option from 1 N to 20000 kN

Transducer

sensitivity

1--40mV/V

Excitation voltage 9VDC

Small Extension ( strain gauge)

Resolution 1/100000

Precision 0.1%

Range Free option from 1mm to 2000mm

Transducer sensitivity 1--40mV/V

Excitation voltage 9VDC

Large range Extension(photoelectric encoder):

Resolution Yielding to the mechanical

system and photoelectric encoder;

normal requirement: 1um

Precision Zero error of the instrument

system

Range Free option from 0mm to 20000mm

Transducer type photoelectric encoder

Position(a photoelectric encoder):

Resolution Yielding to the mechanical

system and photoelectric encoder;

normal requirement: 1um

Precision Zero error of the instrument

system

Range Free option from 0 to 20000mm

Transducer type AB-phase quadruple output

photoelectric encoder

Sampling rate: 50000 times/s

Speed control: (for an electronic universal testing machine):

Control mode Pulse

Frequency coverage 0.072 Hz -- 50 kHz

Precision 0.05% (standard test point)

Speed control: (for an electronic universal testing machine):

Control mode Voltage

Output range 0~5V

Precision 0.05% (standard test point)

Suitable for a servo controller with pulse input or a stepper motor controller with

pulse input; and used for AC frequency variable controller.

1.3 Working conditions
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Temperature: 0～55℃；

Humidity: Relative humidity <85%；

Power: 220±10%VAC, 50Hz；

Away from strong electromagnetic interference.
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2 TM2101 software installation and upgrade guide

2.1 The PC hardware’s requirements:
1). CPU: Intel Celeron 2GHz or higher.

2). Memory: >512MB

3). HDD: >2GB

4). Screen resolution: >1024×768
5). A printer（if need print the report）.

2.2 The PC software’s required:
1. Operation system must be Windows XP.

2. Microsoft Word 2003 is required if you need a report of word format.

2.3 The content in the installation disc
The following folder must be inquired in the disc:

1.”TM2101Vx.xx”: This folder include the measurement and control software, it don’t need

be installed. Just copy it to any place of the HDD.

2.”DriverV8.6”: This folder include the driver of the measurement and control software,

you must install this driver so you can run the soft TM2101Vx.xx.

2.4 Installation guide:
For computer which is first use the test software, the driver should be installed first.

The install process as below:

1. Quit all other application

2. Double click to open “Driver V8.6” folder, the window will look like this:

3. Double click “setup” to start installation program. The welcome dialog will appear:
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4. Click “Next>>” button, read the License Agreement in the following dialog:

5. Check “I accept the License Agreement(s)” option and click “Next>>” to enter the next

step:
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6. Click “Next>>” and start the installation, it may take several minutes, please be

patient until the following screen shows.

7. Click “Finish” to complete the installation. It will ask you whether or not to restart

the windows system immediately.

8. Click “Yes” to restart your computer.

9. Copy “TM2101V2.xx” folder to local disk and double click to open it.
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10. Right-click the “TestMaster” program icon and choose “Send to...” -> “Desktop shortcut”
menu to create a shortcut on the desktop.

11. The software installation is completed.

2.5 Software upgrade guide
If the drivers have been installed before and previous version of TM2101 software can

run, the following steps will guide you to update it to a newer version. Suppose the old

version is “TM2101V2.41” and the new version is “TM2101V2.42”.
1. Copy the folder “TM2101V2.42” that contains the new version to local file system

2. Go to the location of the old version. If you forget the location, you can find it

as following instructions:

Right-click the “TestMaster” shortcut on the desktop
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Choose “Property” menu to open the property dialog:

Click “Find target…”, it will open the folder where the old version is.
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3. Right-click the “data” folder of the old version, choose “Copy” in the popup menu:

4. Open the “TM2101V2.42” folder that contains the new version, Right-click to show the

popup-menu, choose “Paste”:

A Dialog will popup to ask you whether to overwrite the “data” folder:

Choose “All” to overwrite all the data.

5. Delete the old shortcut named “TestMater” on the Desktop. Right-click “TestMaster”
executable and choose “Send to..”  “Desktop shortcut” in the popup menu to create a new

shortcut:
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6. The software is updated.
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3 Operation Guide of TM2101 Software

3.1 Quickstart
A complete testing process includes three steps: Setting before test; execute test and

get test results.

1. Setting before test:

1 Select a sample or add a new sample, as Fig.1；
2 Select a project or add a new project, as Fig.2;

Fig. 1
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Fig. 2

2. Execute test: click ’Test’ button or press its shortcuts ‘F7’ (Refer to 4.1 shortcuts

instruction)，when ’Test’ button is in green connected state，it indicates that testing

process is running and awaiting ending automatically or manual stop the test.

3. Get test results: Testing results will return automatically in the end. You can also

get different test results by choosing other items in the dropdown list. as Fig.3.

Fig. 3

Notice: Testing should be executed in online state.

3.2 Main Interface Introduction
Main interface show in Fig. 1 and Fig. 2:
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Fig. 1
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Fig. 2
Software include title bar, menu bar, current volume displaying bar, control panel, testing time

displaying, lifting speed of machine, manual check point, material selection and modification, testing
methods’ selection and modification, control parameters’ selection and modification, results’
selection and modification, results displaying form, history record operation, report forms
operation ,force - displacement curve display and so on.

Title bar: software name, version information, etc.
Menu bar: Software management and function operation, etc. Details in 3.3 Menu Introduction
Current volume displaying bar: Displaying current value such as Power, displacement. You can

choose displaying items from dropdown list, showing in Fig3.
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Fig. 3
Control Panel: Control the machine up and down and testing execution operation and so on.
Rising and falling speed of machine: Adjust lifting and falling speed of machine.
Snap manually: Snap feature points manually in the curve, details in Fig. 3.4 Function detailed

information-Snap the point manually
Material selection and modification: See details in Fig. 3.4 Function detailed

information-Material editor
Testing method selection and modification: See details in Fig. 3.4 Function detailed

information-Control method
Select and modify the control parameters: See details in Fig. 3.4 Function detailed

information-Control parameters
Select and modify the results: See details in Fig. 3.4 Function detailed information-Testing

Results
Displayed results form: Get required results of testing
History record operation: Open record means open a bypast testing record only one at a time,

when repeated open it would cover the last one; Delete record means delete one or more selected
records; Add record means new open one or more records based on last one.

Report form operation: print form means export report form to the printer for printing execution;
Edit report form means open the report form for editing; Word report form means generate a report
form of Word format according to template of Word report form.

Force-Displacement curve Display: Display test curve. Details in Fig. 3.4 Function detailed
information-Graph Operation

3.3 Menu Introduction
Menu List：
Main menu First level

sub-menu
Illustration Second

level
sub-menu

Illustration

Management
(M)

Log in Details in 3.4 Detailed
explanation of all functions
Log in

Authority
Manageme
nt

Details in3.4 Detailed
explanation of all functions
Authority Management

Modify
password

Details in 3.4 Detailed
explanation of all functions
Modify password

Log out Exit software，short key
Ctrl+Q

Setting(S) Unit
System

Details in 3.4 Detailed
explanation of all functions
Unit System

Calibration Details in 3.4 Detailed
explanation of all functions
Calibration

Connect Details in 3.4 Detailed
explanation of all
functions-Connect

COM1-COM
6

Details in 3.4 Detailed
explanation of all functions
Connect

Other Invalid
Zero(Z) Zeroed Zeroed current force value
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Force
Zeroed
Route

Zeroed current route value

Zeroed
Displaceme
nt

Zeroed current displacement
value

Zeroed All Zeroed all of the above values
Vision(V) Language Simplified

Chinese
Switch to selected language
of the software
Details in 3.4 Detailed
explanation of all functions
Language Switch

Traditional
Chinese
English

Option Details in 3.4 Detailed
explanation of all functions
Option

Help(H) Help
Documents

Open help documents

About… Show information of the
testing system

Register Details in 3.4 Detailed
explanation of all functions
Register

Active Details in 3.4 Detailed
explanation of all functions
Active

3.4 Detailed Information of all functions
1、 Log in
2、 Authority Management
3、 Modify Password
4、 Unit System
5、 Calibration
6、 Online
7、 Swich Language
8、 Option
9、 Register
10、Active
11、Edit Material
12、Control Methods
13、Control Parameter
14、Testing Result
15、Edit Report Form
16、Word Report Form
17、Snap Point Manually
18、Graph Operation
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1. Log in
Click Menu “Management”->”Log in”, or press composite key Ctrl+L(3.5 Shortcut Key lists)

to enter Login interface, as shown in Fig.1:

Fig. 1
Choose user, input correct password and click confirm button, then you can use the

software within corresponding user authority. Administrator owns the highest user authority

and Anonymous owns the lowest. When selected ’Always login as the user’, user will log in

automatically as the same user when software start next time.

2. Authority Management
Click menu “Management”->”Authority Management” to enter Authority Management Interface,

as shown in Fig. 2:

Fig. 2

Authority Management is in disabled status when log in as Anonymous, as anonymous has

the lowest administrative privileges which does not have right of authority management. User

permission of all functions can be set in the Authority Management, the selected item shows

that user owns permission of it, otherwise does not have. For example, in "Authority

Management" project of above picture, Administrator is selected while the tester is not

selected, it shows the administrator has the right of authority management and the tester

does not have the permission.

3. Modify Password
Click menu “Management”-> “Modify login password” to enter Modify Login Password Interface,

see Fig.3:
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Fig. 3

Modified password is current login user's password. For example, when current login user

is administrator, and then modifies the administrator password, when current login user is

tester, and then modifies the tester’s password.

4. Unit System
Click menu “Setting”->” Unit System”, or press composite key Ctrl+U(3.5 Shortcut Key lists)

to enter Unit System Interface, see Fig.4:

Fig. 4

Choose a unit and accuracy from the drop list, the accuracy means the digits after the

decimal point. And the unit determines the unit of the whole system, the operation of all

variable must according to this unit system.

5. Calibration
Click menu “Setting”->” Calibration”, or press composite key Ctrl+Shift+C (3.5 Shortcut

Key lists) to enter Calibration Password Input Interface, see Fig. 5:

Enter into the Calibration Interface after input the right password, see Fig. 6:
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Fig. 5

Fig. 6

The Calibration Interface contains five tabs: Force Sensor、Displacement Sensor、Rubber
Extensometer、Metal Extensometer and System Setting.

1. Calibrate the force sensor

Choose the tab “Force Sensor”, see Fig. 6. In the left side, there are four force sensor

channels: “50kg”、“0.0kg”、“0.0kg”、“0.0kg”.
Calibrate process as below:

1). Plug in a force sensor (for example: range of the force sensor is 50kg) to be calibrated,

select a sensor channel on the left side;

2). Input the range of force sensor into “Range”, for example “50kg”;
3). Input zero value into “Zero”, the default value is “0”;
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4). Click “Empty” to empty the calibration table;

5). Calibrate the first point: empty the sensor, and input “0” kg in “Standard Weight

Value”, then click button “Sample”, so the AD value and standard weight value will be input

into the calibration table;

6). Calibrate the second point: Add certain value of load (for example 5 kg) on the sensor,

and input “5” kg into the “Standard Weight Value”, then click button “Sample”, so the AD value

and standard weight value of the second point will be input into the calibration table;

7). Calibrate the third point: The method is same with the second point, if continue

to calibrate the third point, the AD value and standard weight value of the third point must

bigger than the second point, or the calibration will be inaccurate;

8). Calibrate the forth point: The method is same with the second point, if continue

to calibrate the forth point, the AD value and standard weight value of the forth point must

bigger than the second point, or the calibration will be inaccurate;

9). Calibrate the fifth point: The method is same with the second point, if continue

to calibrate the fifth point, the AD value and standard weight value of the fifth point must

bigger than the second point, or the calibration will be inaccurate;

10). Calibrate the sixth point: The method is same with the second point, if continue

to calibrate the sixth point, the AD value and standard weight value of the sixth point must

bigger than the second point, or the calibration will be inaccurate;

11). Click the button “Write the Standard Data into the acquisition”, the calibration

of a sensor will be completed if prompts “write successful”, please retry if prompts “write
failed”;

12). Please redo 1~11 steps if you need to calibrate the second force sensor, or set

the range of other sensors to zero, then click button “Write the Standard Data into the

acquisition”.
Attention: At least two points should be calibrated, step 7~10 can be skipped. According

to the character of most domestic sensors, normally need 3 points to be calibrated to get

very good accuracy, the value of the second point can be set as 3~5% of the range of sensor,

and the value of the third point can be set as 30~50% of the range of sensor. The AD value

and standard weight value of the latter point must bigger than the point in front if calibrate

more than 3 points, or the calibration will be inaccurate. If the AD value decreases when

the “Standard Weight Value” increases, you can exchange the two signal line of sensor. AD

value is about 8400000 when empty, and the AD value will be proportional change when with

load on the sensor, if the AD value doesn't change when with load on the sensor, there must

be some errors on the hardware, maybe the force sensor damaged or the acquisition card has

malfunction, please contact with manufacturer.

If there is a little difference between measure force value and the standard weight after

calibration, please re-calibrate or modify the value of standard weight in the calibration

table, if the measure force value is bigger than the value of standard weight, modify the

value of standard weight of the second point in the calibration table smaller, then click

button “Write the Standard Data into the acquisition”, then re-clear and re-compare until

the two value become equal.

2. Calibration of displacement sensor

Select “Displacement sensor” tab, see Fig. 7:
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Fig. 7

1). Fill the displacement coefficient value into the right input box of “Displacement
Coefficient”, displacement coefficient means the displacement when the acquisition receive

per 1000 pulses, acquisition card make the encoder lines for the four harmonic, for example

the number of encoder lines is 4, the screw lead is L mm, then the corresponding displacement

coefficient value is L/n/4*1000. If you don’t know the number of encoder lines or screw lead,

you can input any number (for example number “1”) for try.

2). Click button “Write the Standard Data into the Acquisition Card” to write the

displacement coefficient value into the acquisition card;

3). Click button “Clear the Displacement” to clear the current displacement;

4). Click button “Up” or “Down” to make the machine move a certain distance, then measure

the distance via calipers;

5). Check whether the "current displacement" value is equal with the measured value,

if the "current displacement" value is bigger than the measured value, please decrease the

displacement coefficient value, or increase the displacement coefficient value, then click

button “Write the Standard Data into the Acquisition Card” to write the new displacement

coefficient value into the acquisition card;

6). Redo 3~5 step until the "current displacement" value is equal with the measured value;

7). Finish the calibration of displacement sensor;

3. Calibration of rubber extensometer
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If the machine connects with a rubber extensometer (known as the large deformation),

you need to calibrate it. Please choose the “Displacement” for “Rubber Extensometer” via click

“User Parameter Setting” -> “Control Parameter” -> “Sensor” before calibration, or the

calibration could not be carried on. The calibration interface of rubber extensometer is

shown if Fig. 8:

Fig. 8

The calibration process of rubber extensometer is same with the force sensor.

4. Calibration of metal extensometer

If the machine connects with a metal extensometer, you need to calibrate it. Please choose

the “Displacement” for “metal extensometer” via click “User Parameter Setting” -> “Control
Parameter” -> “Sensor” before calibration, or the calibration could not be carried on. The

calibration interface of metal extensometer is shown if Fig. 9:
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Fig. 9

The calibration process of metal extensometer is same with the force sensor.

5. System Setting

Choose “System Setting” tab, see Fig. 10:
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Fig. 10

Velocity Limit：Setting the maximum operate velocity and minimum operate velocity of

machine.

Reverse the Direction of Tensile and Compress：Determine whether reverse the direction

of Tensile and Compress.

Reverse the Direction of Up and Down：Determine whether reverse the direction of up and

down.

Probation Period：Can modify the probation period of software after choose this button,

the software can be continue used only if you input the right license when the probation

period expired.

Modify the Calibration Password：Modify the password calibration interface.

Modify the License：Modify the software License.

Write the Standard Data into the Acquisition：Write the current standard data into the

acquisition card, the data will be valid only when write the data into the acquisition.

Get Standard Data from acquisition card：Get Standard Data from acquisition card to

current display.

Get Standard Data from computer：Get Standard Data from computer to current display.

OK：Save all data, switch the force sensor to the current choose channel. It is independent

with “Write the Standard Data into the acquisition”, Click “OK” does not mean the current

data is valid, the data will be valid only when write the data into the acquisition.

Cancel：Don’t save all data, so the setting is invalid.
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6. Calibration of machine operating velocity

Before calibrate the machine operating velocity, please calibrate the force sensor first,

and disable “User Parameter Setting” -> “Control Parameter”, or the machine operating velocity

could not be calibrated.

6. Connect
Click button “connect” in menu “Set”, chose the right COM to connect the equipment. As

shown in Fig. 11:

Fig. 11

A fail prompt window will be ejected when connect failed (as shown in Fig. 12), if connect

success, no prompt window eject. If the connect success, the software will connect one time

when it startups, the software will connect via the current COM at the next startup time,

the test can be successful only if the connect successfully.

Fig. 12

7. Language Change
Click Menu “View”-> “Language” to change the language of software, as shown in Fig.13:

Fig. 13
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The general version has three types of language: Chinese Simple、Chinese Traditional and English.
And the advanced version has ten types of language, if you have any special requirement, please contact us.

8. Option
Click Menu “View”-> “Option” or press the combination keys Ctrl+Shift+O (See 3.5 Shortcuts),

then you can enter into the option interface, as shown in Fig. 14:

Fig. 14

There are two tabs in the “Option”: “Color” and “Display”, which can set up the color and

display.

9. Registration
Click Menu “Help”-> “Registration” or press and hold on the combination keys Ctrl+R (See

3.5 Shortcuts), then you can enter into the registration interface, as shown in Fig. 15:
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Fig. 15

The software contain a probation period, you can continue to use the software only if

you input the right license when the probation period expired.

10. Activation
Click Menu “Help”-> “Activation” or press and hold on the combination keys Ctrl+Shift+A

(See 3.5 Shortcuts), then you can enter into the activation interface, as shown in Fig. 16:

Fig. 16

According to the license of the system, you can activate the software to the advanced version
after input the right activate license. If connect fail, the license will be shown as 0, the activation can
be operated only if the connect successfully. If the function of the current software could not meet
your test requirement, please contact with us to upgrade to the advanced version.

11. Material Edit
You can choose an existed sample through the drop list of “Sample Data Choose” (As shown

in Fig. 17) or click button “Edit” to add or edit the sample data (As shown in Fig. 18):

Fig. 17
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Fig. 18

Add：Add a new material

Delete：Delete the selected material

OK：Save all modifies

Cancel：Don’t save the modify

12. Test method edit
You can choose an existed Project via drop list of “Project Select” (As shown in Fig.

19) or click button “Edit” to add or edit the control program, each control program contains

“Test Method” and “Control Parameter”, you can click tab “TestMethod” to edit the test

method(As shown in Fig. 20)

Fig. 19
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Fig. 20

Control Mode Value：The 1~20 steps “Control Mode Value” in the “Results List”
Shift Value：The 1~20 steps “Shift Value” in the “Results List”
Switch Condition：The percentage of the value of the switching conditions when transform

into the next action

Name List：List all existed control programs

Add：Add a new test method

Delete：Delete the selected test method

OK：Save all modifies

Cancel：Don’t save the modify

Use Default：Use the default system test method

13. Control parameters
Click tab “Control method” in “Control program”, you can edit the control parameter. As

shown in Fig. 22:
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Fig. 22

Sensor：Choose of force sensor and displacement sensor

Direction：Determine whether the force、distance and displacement to take negative value

or absolute value

Protection：The system will be automatic shutdown when the current value out of the

protection range, choose “Protection” means enable this function

Sample Rate：the number of sampling points per second, you can choose a lower sample

rate for a prolonged period of constant load test

Save Path：The test data will be saved in this path

Filter Coe.：Filter Coefficients, the number of mean value filter.Range 1~1000, Normal

5.

BreakCutPoints：Remove the Last few sample points when the sample fracture

Force Resolution：Determine the minimum scale which the system can display

Use Default：Use system’s the default control parameter

14. Test Results
You can chose a group of existed test result through the drop list of tab “test results

select”, or click “Modify” to add or edit test results, as shown in Fig. 24:
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Fig. 23

Fig. 24

Name List：List all existed test results

Add：Add a new group of test results

Delete：Delete a group of selected test results

OK：Save all the modifies

Cancel：Don’t save all the modifies

The content in the result table is all the needed result for a completed test, you can

add a parameter to the table from the parameter list, or do some operation such as delete、

left shift or right shift via click a table. The button “Add”、”Edit” and “Delete” on the right

side can operate on the parameter list. For example, chose “tensile strength” in the result

parameter, click “Edit” or double click “tensile strength”, then the parameter edit interface

will be eject. As shown in Fig. 25:
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Fig. 25

The name is tensile strength, tensile strength=maximum force/area, in the table above,

you can find out the alternative symbol of maximum force is “h1”, the alternative symbol of

area is “m5”, so the formula is “h1/m5”, and the unit type is stress (strength), the edit

will be finished when click button “OK”. The table above is the explanation of basic parameter

symbol.

You can fill in interval set、automatic sample set and other tab on demand.

15. Report Edit
Click button “Edit Report”, you can enter into the report edit interface. As shown in

Fig. 26:
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Fig. 26
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Input the needed information in header, then click button “Print” can print the report

directly, Click button “Save as” can save the current report as a Word format file, click

button “Close” can exit current file.

16. Word report
Click button “Word report” can generate a word report. User can create a new Word template,

and chose the template in the drop-down list in “Word report” in tab “Others” of menu “Test
Results”, then the Word report will be produced by this template. And a bookmark “Graph” and
a table with two lines and two columns must be included in the template; the position of

the bookmark is the position of the curve, and the table will be replaced by the test results.

As shown in Fig. 27:
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Fig. 27

Click Menu “Insert”-> “Bookmark” to insert a Curve, as shown in Fig. 28 and Fig. 29:
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Fig. 28 Fig. 29
Input bookmark “Graph”, then click 添加(add), the curve will be add to current position

of the cursor.

In addition, if there has a text format “?**?” in the template and the content between

two “?” is same with the character in the test formula table, it will be replaced by the actual

value of the test.

You can change the maximum accommodate column number of the report test result if you

modify “NumColums=10” in file “Config.ini” under folder “data”, the default value is 10.

17. Manual Snap
Click Menu “View”-> “Option”, function manual snap can be activated if you select “manual

Snap” in the display tab. As shown in Fig. 30 and Fig. 31:



41

Fig. 30

Fig. 31

During the test proceed, click button “Snap” or shortcuts F10, will fill the current force、

displacement and time into the form. During the non-test proceed, click button “Snap”, if the

cursor is invisible, it will be visible; if you don’t snap at the first time and the cursor

is visible, then the position of the cursor will be set as the current Snap position.

18. Graph operation
Click right button of the mouse in the curve display window, then the graph operation

will be popped, As shown in Fig. 32:
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Fig. 32

Return：Return to the initial state of the mouse, the mouse must return to initial state

if you want to drag the cursor on the curve

move：Parallel move the curve

Zoom in：Zoom in the curve

Zoom out：zoom out the curve

Zoom area：Press and hold on the left button of the mouse, drag a rectangular box to

zoom in part of the curve

Zoom all：Display the whole curve in the picture

Cursor：Indicate the cursor, current position of the cursor will be display on the upper

right corner, As shown in the blue marking in Fig. 32

Graph Tools：Indicate the graphics tools, show as the red marking in Fig. 32. the graphics

tools can also operate the curve, such as parallel move and zoom

Snap：Has the same function with “Manual Snap”

3.5 Shortcuts
Shortcuts list:

Shortcuts Function Shortcuts Function
F2 Up Ctrl + L Log in
F3 Down Ctrl + Q Exit
F4 Stop Ctrl + U Unit System
F5 Clear Ctrl + Shift + C Calibration
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F6 Back position Ctrl + F Zero Force
F7 Start Ctrl + S Zero Course
F8 Finish Ctrl + E Zero Displacement
F9 Pause/Continue Ctrl + Shift + Z Zero
F10 Manual Sampling Ctrl + Shift + O Option
Ctrl + H Help
Ctrl + R Registration
Ctrl + Shift + A Activation

3.6 Configure files:
Text “AdFilter=5” in file “Initial.ini” means the sliding filter number of AD Value, it will be
effected when write acquisition card in the calibration interface.
Text “NumColums=10” in file “Config.ini” use for control the maximum accommodate column number

of the report test result.
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4 Q&A

Q: The software complains “connection failed” when starting the test, how to solve the

problem?

A: “Connection failed” means the software cannot connect to the machine. Please check

the serial port is correctly connected; the machine is already powered on. If these are

confirmed, click “Option” —> “Connection”, choose the expected COM port to connect. If you

don’t know which COM port to connect, just try each COM port one by one until successful

connected. If all the above are done and the problem remains. Quit the software, power off

the machine, restart both the machine the software and retry.

Q: What to do when the software popup the “Software expired, please contact the provider.”?
A: Please contact the software provider to get registration code. The prompt will disappear after

register the software using the new registration code. For more information, see section 3.4.

Q: When I click “Up” or “Down” the speed of the workbench does not match the configured
speed（faster than expected），how to solve the problem?

A: Please uncheck “User options””Project Edit””control parameters” “Close loop control”.
Please don’t check this option without displacement coder or the displacement has been calibrated.

Q: After click the “Test” button, the workbench works for a while but stops when the sample is
just under stress, how to solve the problem?

A: Please increase the value of “User options””Project Edit” “TestMethod” “Break judge
*.**% of measuring range”. The software will not check break when the test value is below this value.
So that the experiment will not stop at the beginning because of the misjudgment of break.

Q: Encoder not connected, can the workbench back automatically?

A: No. A coder is required for the back function.

Q: When I click “Up” or “Down”, the move direction of the workbench is opposite to the
configured value, how to solve the problem?

A: Please check “Options” “Calibration” “System options” “reverse Up-Down direction”
and click “write to chip” button.

Q: When the value of “Test Method” is set to “Tensile” or “Compress”, the move direction of
the workbench is opposite to the configured value, how to solve the problem?

A: Please check “Options” “Calibration” “System options” “reverse dir.
Tensile&Compress” and click “write to chip” button.
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5 Functional differences between software versions

The software of TM2101 has three versions: Version A (Starter Edition); Version B (Basic

Edition); Version C (Professional Edition). The performance differences between versions

are as follows:

Function Version A Version B Version C
Management for USER Permission Y Y Y
Management for Unit Y Y Y
Calibrate System Y Y Y
Sample Data Editor Y Y Y
One-dimension Tension or Compression Test Y Y Y
Fixed Displacement Test Y Y Y
Fixed Strain Test Y Y Y
Multi-interval Analysis Y Y Y
Fixed Format Reports for Test Results Y Y Y
Word Format Reports for Test Results Y Y Y
Force-Displacement Curve Y Y Y
Force-Time Curve Y Y Y
Displacement -Time Curve Y Y Y
Stress-Strain Curve Y Y Y
Setting of Software Probation Period Y Y Y
Over Range Protection for Force/Route/Displacement Y Y Y
No. of Force Sensor Channels 4 4 4
Rubber Extensometer(for Large Deformation) Y Y Y
Metal Extensometer(for Small Deformation) Y Y Y
Closed-loop Control for Velocity Y Y Y
Closed-loop Control for Displacement N/A Y Y
Closed-loop Control for Force N/A Y Y
Fixed Force Control N/A Y Y
Fixed Stress Control N/A Y Y
Holding Pressure Test with Carton N/A Y Y
Single-pass Go Back and Forth Test N/A Y Y
Repeated Go Back and Forth Cycle Test N/A N/A Y
Multi-layer Nested Reciprocate Cycle Test N/A N/A Y
Multi-step Test N/A N/A Y
Fixed Force & Velocity Control N/A N/A Y
Fixed Stress & Velocity Control N/A N/A Y
Fixed strain & Velocity Control N/A N/A Y
Multi-step Data Analysis Capabilities N/A N/A Y
No. of Automatic Sampling Point 3 6 20
No. of Manual Sampling Point 5 10 30
Language Chinese

Simple
Chinese
Simple/Chi
nese

Chinese
Simple/Chi
nese
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Traditional/
English

Traditional/
English

The control method of version A is 1 step, suit for simple one-dimension tension or compression
test;
The control method of version B is 2 steps, suit for slightly complex test, such as single
reciprocating test and holding pressure test with carton;
The control method of version C is multi-step, suit for various complicated control test.
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6 Technical Support

If you have any question during use process, please contact us, we will be happy to
serve you. Please submit the issue via writing or e-mail, so that we could solve the problem for you
as soon as possible. Although we make every effort to, there maybe still be some omissions and
errors, you are welcome to criticize correction.
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7 Appendix 1: Explanation of some calculate

formula for test result

1. Ring stiffness

Thermoplastic pipe Determination of ring stiffness calculates according to GB/T 9647-2003.

S=(0.0186+0.025Y/d)F/(LY)

F----Force @ 3.0% elongation percentage. The unit is kN.

L----Sample length.The unit is m.

Y----Elongation @ 3.0% elongation percentage.The unit is m,Em.Y/d=0.03.

Please fill the form input fields with the following values:

Gauge column of sample data--> inside diameter of the measured pipe

Width column--> the length of the tested tube

First point of "test results" "auto sample setting" -->3

2. Elastic modulus:

Calculate according to GB8653-1988

Elastic modulus=Stress difference/strain difference of any two points in elastic range

The two points for elastic modulus calculation are set up in Tab “Other” in “Test Result”.

3. Tensile strength

Tensile strength=the large force/area

4. Fracture gauge

The Distance after sample fracture, need manual input.

5. Elongation after sample fracture

Elongation=(Fracture Distance -Original Distance)/Original Distance

6. Upper yield strength

Upper yield=Force on upper yield point/area.

7. Low yield strength

Low yield=Force on low yield point/area

For the material with no significant yield, use Rp0.2 as yield strength.

8. Provision of non-proportional extension strength

Non-proportional extension strength=Force on non-proportional extension point/area.

9. Provision of the total extension strength

Total extension strength= Force on total extension point/area.

10. Shear strength

Shear strength= Large Force/ (Distance * Width)

11. Shear modulus

Shear modulus= (Young’s modulus * Area/ Distance)*Thickness/ (Distance * Width)

12. Maximum bending strength

Maximum bending strength=3 * Large Force * Distance / (2 * Width * Thickness * Thickness)

13. Bending modulus

Bending modulus= (Young’s modulus * Area/ Distance) * Distance * Distance * Distance/ (4 * Width * Thickness

* Thickness * Thickness)

14. SDEV (Standard deviation)
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SDEV= Radical of [(x1-x)^2+(x2-x)^2+......(xn-x)^2]/(n-1). Xn is the value of each sample, x is average of all

samples, n is the number of samples.

15. CPK(Process capability index)

Cpk=Cp(1-|Ca|),其中 Ca=(X-U)/(T/2),Cp =T/(6σ),T＝Upper specification limit – Low specification limit ;

U=( Upper specification limit + Low specification limit)/2; X is the average, σis standard deviation.
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8 Appendix 2: Wiring diagram of RX2101
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9 Appendix 3: Reference of connection diagram for

RX2101 with common servo drive

1. Panasonic A4 series AC servo drive:

The connection diagram can see in the wiring diagram, in addition, some parameters should be configured as

below:

1. P02=0(Position control mode).

2. P42=3(Pulse & direction control mode), P41 is use for change the direction of motor rotation. P48、P49、

P4A、P4B use for joint velocity control, the initial value of them can be set as: P48=10000, P49=1, P4A=0,

P4B=10000. If you use the internal encode of servo motor, please set P44<=2500/reduction ratio of reducer,

P45=0.

3. The frequency range of output pulse is 0.1~50 kHz.

2. Panasonic A series AC servo drive:

P02=0(Position control mode), P42=3(Pulse & direction control mode), P41 use for change the direction of

motor rotation. P46、P4A and P4B use for joint velocity control, the initial value of them can be set as: P46=10000,

P4A=0, P4B=10000.

●The servo drive must be earthling。

The wiring diagram of J2 (input connector of limit detection) and
proximity switches:

▲The force sensor must connect with the board via shield wire, or there may exist some interference.
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10 Appendix 4: Reference of connection diagram

for RX2101 with inverter

J13 use for connect with inverter, the connection diagram as
below:
Helips A series inverter:
Parameters configure:
CD033=1,

CD034=1,

CD068 Use for velocity calibration.

In addition, please pay attention to the configuration of CD007(Maximum

operate frequency)、CD006(Minimum velocity control, prevent the motor hot because of low velocity)、CD012(Time

of start to accelerate)、CD013(Time of stop to slow down)、CD032(Stop mode)、CD066～CD070. For the other parameters,

use the initial value.

Helips C series inverter:
Parameters configure:
C012 (Operation control) =1,

C013 (Operation frequency) =1,

C075 (High-frequency of analog) Use for velocity calibration

In addition, please pay attention to the configuration of C010 (Maximum

frequency) and C100 (Automatic compensation of torque). For the other parameters,

use the initial value.

YTB-S5 & YTB-T5 series inverter:
Parameters configure:
D031 (Source of frequency command) =1,

D032 (Source of operation command) =1,

D093 (High-frequency of analog) Use for velocity calibration

In addition, please pay attention to the configuration of D002 (Maximum

operation frequency), D009 (Maximum output frequency), D062 (Automatic

compensation of torque).For the other parameters, use the initial value.

Delta VFD-M series inverter:
Parameters configure:
P00 (Source of frequency command) =1,

P01 (Source of operation command) =1,

P03 (Maximum operation frequency) Use for velocity calibration

In addition, please pay attention to the configuration of P36 (Minimum output

frequency, prevent the motor hot because of low velocity) 、P37 (Maximum output
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frequency) 、P10 (The first acceleration time) 、P11 (The first deceleration time) 、P54 (Automatic compensation

of torque). For the other parameters, use the initial value.

Taian E2 series inverter:
Parameters configure:
F_10 (Operation control) =1,

F_11 (Frequency control) =1,

F_6 (Maximum frequency) Use for velocity calibration

In addition, please pay attention to the configuration of F_7 (Minimum output

frequency, prevent the motor hot because of low velocity) 、F_1 (The first

acceleration time) 、F_2 (The first deceleration time) 、F_13 (Compensation of

torque). For the other parameters, use the initial value.

Dongyuan 7200CX series inverter:
Parameters configure:
Pn01 (Mode choice of operation stop)=1000,

Pn02 (Maximum output frequency) Use for velocity calibration

In addition, please pay attention to the configuration of Pn07 (Minimum

output frequency, prevent the motor hot because of low velocity) 、Pn18 (The

acceleration time) 、Pn19 (The deceleration time) 、Pn68 (Automatic torque

increase gain). For the other parameters, use the initial value.

Delta VFD-B series inverter:
Parameters configure:
02-00(Source of first frequency command) =01,

02-01(Source of first operation command) =01,

01-01(Rated frequency of the motor) Use for velocity calibration

In addition, please pay attention to the configuration of 01-00 (Maximum

operation frequency) 、01-09 (The first acceleration time) 、01-10 (The first

deceleration time). For the other parameters, use the initial value.

●The inverter must be earthling。

The wiring diagram of J13 with “Up” &”down”
solid state relay or 24V relay:



54

Appendix 5: Example of membrane switch
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